
Virudhunagar District

Common Half Yearly Examination - December 2023

Standard - 11

Computer Application[Answer key]

PART - I
Choose the correct answer
1) Mouse
2) 11011001
3) Complex instruction set computers
4) Shutdown the computer without the running application
5) Title bar
6) 1979
7) F5
8) World Wide Web Consortium
9) <br>
10) Highlight
11) .css
12) Common gateway interface
13) Repitative
14) Library Function
15) Warez

PART - II
Answer Any Six -Compulsory Qn.no 22]

16) Date : Data is defined as an unprocessed collection of raw facts, suitable for communication,
interpretation or processing.
Eg: 134, 16, ‘Kavitha’ ‘C’ are data. This will not give any meaningful message.
Information: Information is a collection of facts from which conclusions may be drawn. Eg: Kavitha is
16 years old.

17) There are two basic types of RAM
• Dynamic RAM (DRAM)
• Static RAM (SRAM)

18) Files: 1. A file is a collection of data on a single unit. It can be anything from a word file to a
music, video or photo file.

2. Files have a size ranging from a few bytes to several giga bytes.
Folders: 1. Folders are places where files are stored. Folders can contain folders inside them.

3. Folders take up no space on hard drive.

19) Yes, you can edit the contents of a cell in several distinct ways. Use this method convenient for you,
1. Double-click the cell you would like to edit. The cursor is placed where you double clicked.

2. Press the F2 key, the cursor is placed at the end of the text.
3. Click anywhere in the formula bar. The formula bar changes to have an entered and check

mark.

20) Internet Corporation for Assigned Names and Numbers (ICANN) administers the domain name
registration. It helps to avoid a name which is already registered.

21) The <big> tag is used to define the text bigger in size than the normal size. It is often
used to call attention to a text.
The <small> tag is used to define the text smaller than the current size.
These two tags are container tags.

22) General format of linking CSS with HTML
<Link rel = “stylesheet” type = “text/css” href = CSS_File_Name_with_Extension>
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23) Break Statement: 1. The break statement will terminate the loop early.
2. The break statement is executed and the loop is terminated.

Continue Statement: 1. The continue statement will skip back to the loop condition check.
2.When the continue statement is executed, the current is iteration of the

enclosing loop is terminated.

24) A cookie is a small piece of data sent from a website and stored on the user’s computer memory by
the user’s web browser while the user is browsing internet.

PART - III
Answer Any Six question [Compulsory Qn.no 25]
25)

26) The key features/characteristics of the operating system are:
1.User Interface 2. Memory Management 3. Process Management
4. Security Management 5. Fault Tolerance 6. File Management.

27) Move:1)When an object is move from a document. It is completely removed and placed into a
clipboard.

2)Ctrl+X and Ctrl+V is the shortcut command for cut and paste.
Copy:

1)When an object is copied a duplicate of it is placed into a clipboard while the original
remains in place.
2)Ctrl+c and ctrl+v is the shortcut command for copy and paste.

(Or)
To copy a text from one location to another
• select the text to be copied
• Click Ctrl + C or Copy Icon or
Edit → Copy
• A duplicate copy of the text is made and sent to the clipboard
• Take the insertion pointer to the new location to be copied and
• Click Ctrl + V or Paste Icon or Edit→ Paste
The required text is copied to the new Location.

To move a text from one location to another
• Select the text to be moved
• Click Ctrl + X or Cut Icon orEdit →Cut
• The text is removed from the source location and placed in the clipboard
• Take the insertion pointer to the new location to be moved and
• Click Ctrl + V or Paste Icon or Edit → Paste
The required text is moved to the new
location.

www.Padasalai.Net                                         www.TrbTnpsc.com

Kindly send me your answer keys to us - padasalai.net@gmail.com

www.P
ad

as
al

ai
.N

et

www.P
ad

as
al

ai
.N

et

https://www.whatsapp.com/channel/0029VaAqUqk9Bb672tBn033m
https://www.whatsapp.com/channel/0029VaAqUqk9Bb672tBn033m


28) Slide sorter view is to rearranged the sliders. A thumbnail of each slide in order, use this view to
rearrange the order of slides, produce a timed slide show, or add transitions between selected slides.
The tasks pane on the right displays four pages that allow you to specify the master slide, layout,
transitions, and animation effects for the object on your slides.

29)<html> tag has two attributes viz. dir and lang to specify the text direction and language setting
respectively.

30)The <IMG> tag along with the attribute src (Source) is used to add images in HTML
document.
General format:
<img src = image_name_with_extension>
(OR)
<img src = URL>
Example:
<img src = image1.gif>
Src attribute is the main attribute used to specify the file name of the image to be
inserted. If the image is not in the current working folder, the image file name should clearly
specify with the path of the file or URL, where the file is available.
Example:
<img src = “D:\images\animals\cat.jpeg”>

31) The + operator performs addition on numbers but also serves as the concatenation operator for
strings. Because string concatenation has precedence over “numeric addition, + will, be interpreted as
string concatenation if any of the operands are strings. + operator which is also called as the string
concatenation operator.

32)
<html>
<body>
<script>
var I,n=10,sum=0;
arr = new array(1,2,3,4,5,6,7,8,9,10);
var sum =sumno();
document.writeln(“Sum of 10 number is :”+sum);
function sumno()
{
for(i=0;i<10;I++)
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sum=sum+arr[I];
return sum;
}
</script>
</body>
</html>

33)Programming languages to develop software in computers and smart phones are available only in
English. Based on Python programming language, the first Tamil programming language “Ezhil”
(எழில ) is designed.

PART-IV
Answer the Following Question
34)a)
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B)

35) a)A Microprocessor’s performance depends on the following characteristics:
1. Clock speed 2. Instruction set 3. Word size.

1. Clock Speed: Every microprocessor has an internal clock that regulates the speed at which it
executes instructions. The speed at which the microprocessor executes instructions is called the clock
speed. Clock speed is measured in MHz (Mega Hertz) or in GHz (Giga Hertz).
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2. Instruction Set: A command which is given to a computer to perform an operation on data is called
an instruction. Basic set of machine level instructions that a microprocessor is designed to execute is
called as an instruction set. This instruction set carries out the following types of operations: Data
transfer, Arithmetic operations, Logical operations, Control flow, Input/output.

3. Word Size: The number of bits that can be processed by a processor in a single instruction is called
its word size. Word size determines the amount of RAM that can be accessed by a microprocessor at
one time and the total number of pins on the microprocessor. Total number of input and output pins in
turn determines the architecture of the microprocessor.

B)To find a file or folder:
1. Click the Start button, the search box appears at the bottom of the start menu.
2. Type the name of the file or the folder you want to search. Even if you give the part of the file or
folder
name, it will display the list of files or folders starting with the specified name.
3. The files or the folders with the specified names will appear, if you click that file, it will directly
open
that file or the folder.
4. There is another option called “See more results” which appears above the search box.
5. If you click it, it will lead you to a Search Results dialog box where you can click and open that file
or the
folder.

Searching Files or folders using Computer icon
1. Click Computer Icon from desktop or from Start menu.
2. The Computer disk drive screen will appear and at the top right corner of
that screen, there is a search box option.
3. Type the name of the file or the folder you want to search. Even if you give the part of the file or
folder name, it will display the list of files or folders starting with the specified name.
4. Just click and open that file or the folder.

36) A)You can create a presentation by any one of the following types.
1. By selecting an Empty presentation.
2. By selecting From template.
3. By selecting from Open existing presentation.

Using Empty presentation
1. Select Empty presentation under Type. It creates a presentation from scratch.
2. Click Next. The Presentation Wizard step 2 appears.
3. Choose a design under Select a slide design. The slide design section gives you two main choices:
Presentation
Backgrounds and Presentations.
4. Each one has a list of choices for slide designs. If you want to use one of these other than the
<Original>, click it to select it. The preview of the same will be shown in the preview pane.
5. <Original> is an empty background. You can also select among three predefined Presentations:
<Original>,
Introducing a New Product, and Recommendation of a Strategy.
6. Click an item to see a preview of the slide design in the Preview window.
7. Select how the presentation will be used under Select an output medium. Generally, presentations
are created
for computer screen display, so select Screen option.
8. Click Next. The Presentation Wizard step 3 appears . In this step, you can choose the desired slide
transition from the Effect drop-down menu. Select the desired speed for the transition between the
different
slides in the presentation from the Speed drop-down menu. Medium is a good choice. Click Create. A
new
presentation is created.

Using Template
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• If you choose the option From template, it uses a template design already created as the basis for a
new
presentation. The wizard changes to show a list of available templates. Choose the template that you
want.
• Introducing a New Product and Recommendation of a Strategy are pre-packaged presentation
templates.

Using Open existing presentation
• If you choose the option Open existing presentation, it helps in continuing the work on a previously
created
presentation.
• You have to open a presentation already prepared by clicking Open button. The wizard changes to
show
a list of existing presentations, from which you can choose the one thatyou want.

B) Explain Any 5 Internet Apllication
1. Internet telephony using VoIP (Voice-over-Internet Protocol) Example Skype

2. Job search :-Nowadays, many people search for their jobs online using naukri.com,monster.com,
recuritmentindia.com etc as it is quicker .

3. Online Shopping :-The internet has also facilitated the introduction of a new market concept
consisting of virtual shops. For example amazon.com

4. Stock market updates :- Selling or buying shares sitting on computer through internet. Several
websites like ndtvprofit.com, moneypore.com, provide information regarding investment

5. Travel :- One can use internet to gather information about various tourist place. It can be used for
booking Holiday tours. Some of the web sites providing this service are goibibo.com, makemytrip.com,
olacabs.com.

6. Research :-Research papers are present online which helps the researcher do a literature review

7. Video conferencing :- It enables direct face-to-face communication across networks via web cameras,
microphones, and other communication tools.

8. e –commerce :- e–commerce (electronic commerce or EC) is the buying and selling of goods and
services, or the transmitting of funds or data, Largest e-commerce companies in India are Flipkart,
Snapdeal, Amazon India, Paytm.

9. Online payments :- The rising boom of online payments in India has given way to many new
entrants in the industry such as Paytm etc who are majorly wallet driven payment companies.

10. Social Networking :- Social networking is the use of internet-based social media programs to make
connections with friends, family etc. Examples of social networking includes Facebook

11. Voicemail :-Voicemail is a system of sending messages over the phone.

12. Chatting :-On the Internet, chatting is talking to other people who are using the Internet at the same
time you are.

13. e-banking :-e-banking (Online banking) , also known as internet banking, it is an electronic
payment system that enables customers of a bank or other financial institution to conduct a range of
financial transactions through the financial institution's website.

14. e-learning :-e-Learning are courses that are specifically delivered via the internet to somewhere
other than the classroom where the professor is teaching. It is not a course delivered via a DVD or CD-
ROM, video tape or over a television channel
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37)A)

B) HTML supports three types of lists viz. numbered, unnumbered and definition. These
lists are called as Ordered List, Unordered List and Definition List respectively.
1. Numbered List / Ordered List
Numbered list is created within the tag pair <OL> ….. </OL> tag. The tag <LI> is used
to present the list item in the list. Ordered list displays items in a numerical or alphabetical
order. Both <OL> and <LI> tags are container tags. But the usual practice, closing tag
</LI> is normally not used.

Un-numbered List / Unordered List: Unordered lists are often referred as bulleted lists. Instead of
numbers, each element in the list has prefixed with a special bullet symbol. Unordered list is
surrounded within <UL>……………..</UL> tags. As discussed above, each list element is defined by
<LI> tag.

3. Definition List
Definition list is different from other two types of list. No bullet or number is provided
for the list items. In this list type, the list element has two parts.
(1) A definition term
(2) The definition description
Definition list is surrounded within <DL> ……. </DL> tags.
Definition term is presented in between <DT> ….. </DT> tag and
Definition description should be surrounded within <DD> ………… </DD> tag.

38)A)
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B)
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